
    


    







  
    
      
        
          
            
          
        
        
          
          
            PDFelement: PDF Editor, Scanner

            Edit, Convert, Annotate PDF

            Edit, Annotate PDF

          

        

      

      OPEN
      OPEN
    

  




  
    
      
        
          wondershare
        

        
          
            
          
          
            
          
        
        
          	
  
    Video Creativity
    
      
    
  
  
    
      
        Video Creativity Products

        
          
          
            Filmora
            Complete video editing tool.

          

        
        
          
          
            DemoCreator
            Efficient tutorial video maker.

          

        
        
          
          
            UniConverter
            High-speed media conversion.

          

        
        
          
          
            Virbo
            Powerful AI video generator.

          

        
        
          
          
            Presentory
            AI video presentation maker.

          

        
        View all products
      

      
        Explore

        	Overview
	Video
	Photo
	Creative Center


      

    

  


	
  
    Diagram & Graphics
    
      
    
  
  
    
      
        Diagram & Graphics Products

        
          
          
            EdrawMax
            Simple diagramming.

          

        
        
          
          
            EdrawMind
            Collaborative mind mapping.

          

        
        
          
          
            EdrawProj
            A professional Gantt chart tool.

          

        
        
          
          
            Mockitt
            Design, prototype & collaborate online.

          

        
        View all products
      

    

  


	
  
    PDF Solutions
    
      
    
  
  
    
      
        PDF Solutions Products

        
          
          
            PDFelement
            PDF creation and editing.

          

        
        
          
          
            Document Cloud
            Cloud-based document management.

          

        
        
          
          
            PDF Reader
            Simple and free PDF reading.

          

        
        
          
          
            HiPDF
            Free All-In-One Online PDF Tool.

          

        
        View all products
      

    

  


	
  
    Data Management
    
      
    
  
  
    
      
        Data Management Products

        
          
          
            Recoverit
            Lost file recovery.

          

        
        
          
          
            Repairit
            Repair broken videos, photos, etc.

          

        
        
          
          
            Dr.Fone
            Mobile device management.

          

        
        
          
          
            MobileTrans
            Phone to phone transfer.

          

        
        
          
          
            FamiSafe
            Parental control app.

          

        
        View all products
      

    

  


	Explore AI
	Business
	Shop
	Support
	
              Sign in
            
	
              
              
                
                Account Center
                Sign out
              

            


        

      

    

  
  
    
      
        
          
            
            PDFelement
          
        

        
          
            
          
          
            
          
        
        
          	
              
                Products
                
                  
                    
                  
                

              
              
                
                  
                    
                      
                        
                          
                            Desktop

                            
                            	
                                
                                  
                                    
                                    
                                    
                                    
                                  
                                  PDFelement for Windows
                                
                              
	
                                
                                  
                                    
                                  
                                  PDFelement for Mac
                                
                              
	
                                
                                  
                                    
                                  
                                  PDF Reader for Windows
                                
                              


                          

                        

                        

                        
                          
                            Mobile App

                            
                            	
                                
                                  
                                    
                                  
                                  PDFelement for iPhone/iPad
                                
                              
	
                                
                                  
                                    
                                  
                                  PDFelement for Android
                                
                              
	
                                
                                  
                                    
                                  
                                  InstaScan - PDF Scanner for iPhone
                                
                              


                          

                        

                        

                        
                          
                            Cloud & SDK

                            
                            	
                                
                                  
                                    
                                  
                                  Document Cloud
                                
                              
	
                                
                                  
                                    
                                    
                                  
                                  PDFelement Pro DC
                                
                              
	
                                
                                  
                                    
                                    
                                  
                                  PDFelement SDK
                                
                              


                          

                        

                        

                        
                          
                            
                              What's New
                            

                            
                            	
                                
                                  
                                
                              


                          

                        

                      

                    

                  

                

              

            
	
              
                Solutions
                
                  
                    
                  
                

              
              
                
                  
                    
                      
                        
                          
                            Educational Users

                            
                            	
                                
                                  
                                    
                                    
                                    
                                    
                                    
                                    
                                    
                                  
                                  Read PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                  
                                  Annotate PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                    
                                  
                                  Create PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                    
                                  
                                  Combine PDF
                                
                              


                          

                        

                        

                        
                          
                            Personal Users

                            
                            	
                                
                                  
                                    
                                    
                                    
                                  
                                  Convert PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                  
                                  Edit PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                    
                                    
                                  
                                  Compress PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                    
                                    
                                    
                                    
                                    
                                    
                                    
                                  
                                  Organize PDF
                                
                              


                          

                        

                        

                        
                          
                            Professional Users

                            
                            
                              	
                                  
                                    
                                      
                                      
                                      
                                      
                                      
                                    
                                    PDF Form
                                  
                                
	
                                  
                                    
                                      
                                      
                                    
                                    Sign PDF
                                  
                                
	
                                  
                                    
                                      
                                      
                                    
                                    Protect PDF
                                  
                                
	
                                  
                                    
                                      
                                      
                                      
                                      
                                      
                                    
                                    Batch PDF
                                  
                                


                              	
                                  
                                    
                                      
                                      
                                      
                                      
                                      
                                    
                                    PDF OCR
                                  
                                
	
                                  
                                    
                                      
                                      
                                      
                                      
                                    
                                    Extract PDF Data
                                  
                                
	
                                  
                                    
                                      
                                    
                                    AI-Powered PDF Tool
                                  
                                
	
                                  
                                    
                                      
                                      
                                      
                                    
                                    eSign PDFs Legally
                                  
                                


                            

                          

                        

                        
                          
                            
                              Industries
                            

                            
                            
                              	
                                  Education
                                
	
                                  IT Service
                                
	
                                  Legal
                                
	
                                  Healthcare
                                


                              	
                                  Financial
                                
	
                                  Government
                                
	
                                  Publishing
                                
	
                                  Freelancer
                                


                            

                          

                        

                      

                      
                        All PDF Features
                      

                    

                  

                

              

            
	
              
                Resources & Help
                
                  
                    
                  
                

              
              
                
                  
                    
                      
                        
                          
                            Hot Topics

                            
                            	
                                Top List
                              
	
                                Mac Software
                              
	
                                PDF Apps
                              
	
                                OCR PDF Tips
                              
	
                                Sign PDF Tips
                              
	
                                Edit PDF like Word
                              
	
                                PDF Converter Tips
                              
	
                                PDF Compressor Tips
                              


                            Find More Topics
                          

                        

                        

                        
                          
                            
                              
                                Why PDFelement

                                
                                	
                                    Customer Stories
                                  
	
                                    PDF Software Comparison
                                  


                              

                            

                            
                              
                                Better Use

                                
                                	
                                    Tech Specs
                                  
	
                                    Contact Support
                                  


                              

                            

                            
                              
                                User Guide

                                
                                	
                                    PDFelement for Windows
                                  
	
                                    PDFelement for Mac
                                  
	
                                    PDFelement for iOS
                                  
	
                                    PDFelement for Android
                                  


                              

                            

                            
                              
                                 

                                
                                	
                                    PDF Reader
                                  
	
                                    Document Cloud
                                  
	
                                    InstaScan for iPhone
                                  


                              

                            

                          

                        

                        

                        
                          
                            Explore More

                            
                            	
                                Reviews
                                See what our users say.

                              
	
                                Free PDF Templates
                                Edit, print, and customize free templates.

                              
	
                                PDF Knowledge
                                PDF-related information you need.

                              
	
                                Download Center
                                Download the most powerful and simple PDF tools.

                              


                          

                        

                      

                    

                  

                

              

            
	
              Upgrade
            
	
              Business
            
	
              Download
              Download
              Pricing
              Pricing
            
	
              
                
                  
                    
                    
                  
                
              
            


        

      

    

  


 



    
      
    
      
        
          
            Wondershare PDFelement

			   Home  > PDF Solutions > Publishing
            File And Format Things In Publishing Workflow Can Be A Breeze With PDFelement

            PDF can play an important role in every step of the traditional or self-publishing workflow. Whether in creating, proofreading, publishing, or collaborating, properly using PDF can bring tremendous efficiency gains.
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        Why do publishers prefer PDFs? Know more about digital documentation in (e-)book publishing.

        PDF is a file format widely used in the print and publishing industry, especially the PDF/X series of standards. However, the traditional publishing industry seems to be moving towards digitalization, which brings more opportunities for e-book formats. The Statista Digital Market indicates that there were more than one billion e-book users worldwide in 2021.
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                Customer Success | Patricia Jones in 105publishing

                Boost communication between publishers, authors, and illustrators.

                A scalable and reliable alternative to Adobe Acrobat, which reduces costs by 70%.
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                      This tool is so user-friendly. It allows me to move pages around and delete pages without changing any of the contents in the PDF. I don't know of any other software that allows you to do this.
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                   Step 1. Open the PDF file with PDFelement. 

 Step 2. Click on the Word icon under the Convert tab and Save the PDF file to Word format.

 Step 3. Open a blank PUB page with Microsoft Publisher. Then click on Insert > Insert File, and choose the Word document to import the text in the PDF to the PUB file.
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                  Both InDesign and Publishers are excellent design tools and have their own capabilities and strengths suitable for different design needs. 

  Publisher is designed for normal MS Word users who also want design capabilities. It is only available for Windows (PCs) and is more suitable for printed products, such as flyers and brochures, which may be printed with laser or InkJet printers. 

  InDesign is a more sophisticated product known for precision in layouts and numerous output formats. If you need primarily digital assets and advanced capabilities, you will choose InDesign.
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Step 1. Open the PDF with PDFelement for Mac.


Step 2. Click the File > Print option to open the Print dialog.


Step 3. In the Print window, set the parameters for the booklet you want to print on Mac.


Step 4. Finally, click on Print to send the job to your printer. Then, you can bind the printed papers to create a handy booklet.
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                      You can use Adobe Acrobat to convert an INDD file to PDF format.


Step 1. Launch Adobe Acrobat and click Tools > Create PDF from the top menu bar.


Step 2. Select Single File or Multiple Files and drag and drop the INDD file to the window. 


Step 3. The converted PDF will be opened automatically in the Acrobat software. Save it to your local drive. Thus, your INDD file has been converted to PDF.


Step 4 (Optional). Use PDFelement to edit the converted PDF as you like.
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                     PDF to flipbook conversion could be easy like a breeze with appropriate tools. Offline programs like PDF to Flipbook Maker and AnyFlip for Desktop are simple and hassle-free converters. Online tools like Heyzine, VisualParadigm, FlipBookPDF, and Flipsnack can help you turn PDF documents into fabulous flipbooks online. 

  Note: Ensure all pages in your PDF are the same size if you don't want your flipbook to look shabby. You can use PDFelement's crop feature to cut the pages into the same size.
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        Please let us know how we're doing by taking the survey. We use your feedback to improve our products and services. If you've already filled out the survey, thank you for your time and answers.
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